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Installing the EFT Outlook Add-In
To use the Workspaces with Outlook, you must first install the EFT Outlook   Add-In. You 
can use the deployment   script available on the Workspaces   File Send tab of the Site to   
deploy it to multiple computers at once in any deployment tool that   you normally use, or 
you can install it with the EFT Outlook Add-In installer   as described below.

NOTE: If  a "Publisher cannot be verified" prompt appears during the installation of the 
EFT Outlook Add-In, ensure that you are using the latest version of Microsoft Office 
2019.

Before installing, refer to the system   requirements.

When configuring Outlook to send files with Workspaces, ensure the following   
configuration is set:

 l The user account must have Allow    Secure File Sending enabled on the user    
account's Connections tab.    

 l Kerberos requires the administrator to set    the SPN for the account EFT is using. 
 l All user accounts need folder creation at their root folder    enabled.

To install the EFT Outlook Add-In
 1. Get the installers from the installation folder (for example, C:\Program    

Files\Globalscape\EFT Server\OAI).
 l EFTOutlookAddinInstaller.msi     - This is the main installer.
 l EFTOutlookAddinSetup.exe     - This executable contains files that are 

needed by the main installer.
 2. Start the EFTOutlookAddinInstaller.msi    installer and click Next on    the Welcome 

page.
 3. Click Next.
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/ Installing the EFT Outlook Add-In

 4. Specify the EFT Server Host    (URL) and Port, then click    Next.

 5. Specify the location in which to install the Add-In, then click    Next.
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/ Installing the EFT Outlook Add-In

 6. Specify the location to store temporary copies of attachments    while they are 
processed, then click Next.

 7. Click Install.

 8. When installation is complete, click Finish.    Outlook is launched.
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 9. In Outlook 2013 and 2016, the Choose    Profile dialog box appears.

 10. Specify which profile you want to configure for use with the    EFT Outlook Add-In, 
then click OK.

 11. When Outlook opens, it will ask if you want to install the Add-In.    Click Yes.
 12. If there are issues with the EFT SSL certificate, you will be    ask if you want to 

accept it. Click Yes.    (Clicking No will disable    the Add-In.)
The EFT Outlook Add-In options appear on the menu and in new emails.
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/ EFT Outlook Add-In Interface

EFT Outlook Add-In Interface
The EFT Outlook Add-In allows you to send files from Outlook for pickup   via a secure link. 
When the user interface is enabled, the EFT Outlook   Add-in options are available in 
Outlook:

When you create a new email, the EFT Outlook Add-In options appear:

 l If the EFT Outlook Add-in does not appear in Outlook,    refer to Enabling    or 
Disabling the Outlook Add-In.

 l If the EFT Outlook Add-in options are unavailable,    check the following settings:
 o The account used to connect to EFT is not valid.     Be sure that an EFT user 

account is used to connect     to EFT.
 o The Add-in is unable to communicate with the EFT     server. This could be 

caused by a number of issues, including     incorrect connection     information, 
invalid     or blocked user account, or blocked     IP address from multiple invalid 
connections.

 o Outlook Add-in is disabled in Outlook     or in EFT.
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/ Changing the Message Format in Outlook

Changing the Message Format in Outlook
The procedures below describe   how to change the message format, depending on your 
version of Outlook.

To change the message format for all messages
 1. Click the File tab.
 2. Click Options.
 3. Click Mail.
 4. Under Compose messages,       in the Compose messages in this format      list, click 

HTML or Plain Text.

To change the format of an individual outgoing message
 1. With the message open, on the main menu, click Format      Text.
 2. On the Format tab, click       the format you want to use (Plain      Text or HTML).

NOTE: Rich Text-formatted (RTF) messages are not supported.   

Connecting to EFT from Outlook
Typically, the EFT Outlook Add-In server connection information is configured   by the 
administrator. You should not edit these settings unless directed   to do so by your 
administrator. EFT administrators should also refer to   Configure a Service Principal   
Name SPN for Windows Authentication, below, to configure Integrated   Windows 
Authentication (Kerberos). 

You might want to edit these settings are if your username/password   has changed, if 
the server is moved to another host, if your login type   was changed, or if you need to 
change the log file location.

If the EFT Outlook Add-In is not connected to the server, it will not   try to upload 
packages.

In the General Configuration   dialog box, accessed from the EFT Outlook Add-In 
toolbar/ribbon, you can   specify to which server you want to connect, how to 
authenticate your   connection, and where to save log files. In most cases, your 
administrator   will configure this for you during setup.

To configure the EFT Outlook Add-In
 1. On the EFT Outlook    Add-In toolbar/ribbon, click General    Configuration. The 

General    Configuration dialog box appears.
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 2. In the EFT Server    Host box, provide the host name of EFT.
 3. In the Port    box, provide the port used by EFT for HTTPS connections.

 4. 
In the Authentication    type box, specify either manual or Windows authentication:
 

 l Manual—You     must provide the username and password that you use to 
connect     to EFT or your AD credentials.

 a. In the Username      box, provide the username      that you use to connect to 
EFT or your AD username.

 b. 

In the Password      box, provide the password      that you use to connect to 
EFT or your AD password.
 

Use the EFT login credentials for the EFT user account,      not the 
administrator.

 l Integrated Windows     Authentication—Used this login type if you connect to 
EFT     via Single Sign On (Kerberos). In this case, you do not need to     provide a 
username and password. Your Windows credentials are     used to connect.

 5. If you want to test your connection, click Test    Connection.
 6. (Optional) In the Log    file location box, specify the path at which the log file is    

saved.
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 7. Click OK to    save your changes, or click Cancel    if you do not want to save your 
changes.

Configure   a Service Principal Name (SPN) for Windows Authentication

Use this topic as a checklist to correctly configure the Outlook Add-In   so that users can 
authenticate with EFT using integrated Windows Authentication.

Why do I need an SPN? According   to Microsoft   Technet, "A service principal name 
(SPN) is the name by which   a Kerberos client uniquely identifies an instance of a service 
for a given   Kerberos target computer. If you install multiple instances of a service   on 
computers throughout a forest, each instance must have its own SPN.   A given service 
instance can have multiple SPNs if there are multiple   names that clients might use for 
authentication. For example, an SPN always   includes the name of the host computer on 
which the service instance is   running, so a service instance might register an SPN for 
each name or   alias of its host."

Using the Windows "setspn" utility, create the Service Principal   Name (SPN), which is 
necessary for Kerberos to function correctly for   EFT. The SPN is a name by which the 
Add-In can uniquely identify the EFT   Server service.

The “setspn” utility is typically installed by default on Active Directory   server computers. 
The command must be run using an account with Active   Directory administration rights. 
Typically it is easiest to perform these   steps on the domain’s primary Active Directory 
server.

To create the SPNs, execute   the following at a command prompt:

setspn –A HTTP/eftserver eftpreauthuser

setspn –A HTTP/eftserver.globalscape.local eftpreauthuser

setspn –A HTTP/eftserver.globalscape.com eftpreauthuser

Where:

 l eftserver eftpreauthuser is the host name of the computer running    EFT; the host 
name that workstations would use internally to communicate    with the EFT 
computer.

 l eftserver.globalscape.local eftpreauthuser is the fully qualified    host name of the 
computer running EFT; the full host name that workstations    would use internally 
to communicate with the EFT computer.

 l eftpreauthuser with the username of Active Directory domain    account used in 
the “KDC pre-auth username” field of the EFT Kerberos    Configuration.

 l eftserver.globalscape.com is the address to which the Add-In    will connect.
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Do not   type "HTTP://" -- the proper prefix is "HTTP/"

These SPNs should work regardless of the account the EFT server service   is running as.

If duplicate SPNs exist (meaning multiple     domain accounts with the same 
HTTP/<SPN>), then Kerberos     will not work correctly. Once the SPN has been associated 
with     the Kerberos Pre-Auth Account used by EFT to participate in Kerberos     
Authentication, you can double-check for duplicate SPNs on the     domain using the 
command:  setspn     –X.

To view the SPNs to verify that they were created successfully, run   the following 
command after substituting <PreAuthUsername>   auth user account:

setspn –l <PreAuthUsername>

(Note: The switch is a lower-cased letter L, not the number   one.)

Configuring Message Options in Outlook
You can configure message options for all emails or for a specific email.   In each email 
that you send, you can specify message options that pertain   to that email only, 
overriding the default send options. You can make   these settings stricter, but not less 
strict. Each procedure is described   below.

Use the Message Options dialog   box to specify whether the EFT Outlook Add-in should:

 l Expire links
 l Use authentication
 l Notify on pickup
 l Manage embedded attachments
 l Queue or send emails when EFT is not available

To configure message options   to apply to ALL emails
 1. On the EFT Outlook Add-In toolbar/ribbon, click Message Options. The Message    

Options dialog box appears.
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 2. On the Default Send    Options tab, specify expiration, authentication, and 
notification    options.

 3. If you want EFT to manage embedded attachments, such    as a signature logo, 
select the Manage    embedded attachments check box.

 4. On the Offline behavior    tab, specify the following options:

 l Queue emails     until EFT server is available—Emails are sent after EFT     
server becomes available.
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 l Send emails via     Outlook without EFT Outlook Add-in—Emails are sent 
immediately,     but not managed by EFT.

 l Prompt me for     desired behavior—Display a prompt when EFT is not 
available     so you can choose whether to send immediately or hold the email     
until EFT is available.

 5. Click OK to    save your changes, or click Cancel    if you do not want to save your 
changes.

To configure   send options for a specific email
 1. Create the email as you normally do.
 2. In the EFT Outlook Add-In area, click the options    you want to change just for this 

email.
 3. In the Send Options    dialog box, you can specify the following options:

 l Offload attachments—Embedded     attachments are files that are inserted 
into the body of the email     rather than attached to the email, such as a 
company logo in an     email signature or a picture. If you want to make these 
embedded     attachments into file download links, select the check box. 
(Cleared     by default.)

 l Expire File Links—When     selected, the ability to download the attachments 
will expire     in the time that you specify. If the recipient attempts to download     
a file that is past its expiration date, the following message     appears: “The 
file you are attempting to download has expired.     Please contact the sender 
if this file needs to be resent.” (Cleared     by default.) 

 o If the administrator has selected the Retain      files after link expiration 
check box, the temporary Workspace      is removed from the virtual file 
system in EFT, but the files      are still available on disk until the "retain 
files"      expiration date. 

 l Authentications—Require     the user to log in to download an attachment 
from the Pick-up     portal. Selecting this check box helps prevent unwanted 
downloads     from email forwarding and such, and also helps guarantee that     
the person downloading the file is the intended recipient.

 o If the user clicks on an individual file link,      the login or account creation 
page will be displayed in their      default browser. After authentication is 
successful,      the "open/save" dialog appears.

 o If the user clicks on the Pick-up portal link,      the login or account 
creation page will be displayed in their      default browser. After 
authentication is successful,      they will be taken to the Pick-up page for 
that specific package.
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 o When the check box is selected, only the Pick-Up      page link is sent. If 
the check box is not selected, individual      links for each file are included 
in the email.

The authentication will be saved in their session, so clicking     multiple 
individual file links will not require multiple log-ins. (The     session length is 10 
minutes.)

 l Notifications—When     selected, download notification is sent to you when 
the recipient     clicks the download link in the email or Download Files on the     
Pick-Up page.

 4. Click OK to    save your changes or Cancel    if you do not want to save your 
changes.

Enabling or Disabling the Outlook Add-In in Outlook
If the EFT Outlook Add-In options do not appear in Outlook you need   to enable it. Or in 
the rare instance of an error, you may you need to   disable the Outlook Add-In or reenable 
it.

To enable or disable the Outlook Add-In
 1. Click File > Options.
 2. In the left pane, click Add-Ins.
 3. In the Manage    box, click COM Add-Ins, then    click Go. The COM    Add-Ins dialog 

box appears.
 4. Select (turn on) or clear (turn off) the EFT    Outlook Add-In check box, then click 

OK.

Take note of the state of the Add-In in the Trust Center (i.e. Active,    Inactive, or 
Disabled). If the Add-In is in a disabled state, it cannot    be enabled using the steps 
above initially. Instead, you must perform    the following steps in the Trust Center:

 a. Next to the Manage     box, click Disabled Items,     then click Go.
 b. In the Disabled Items     dialog box, click EFT Outlook     Add-In, then click 

Enable.
 c. Close the Disabled Items     dialog box.

 5. If the Add-In now appears in the Active list, it is enabled. If    the Add-In appears in 
the Inactive list, follow steps 3-4 above.
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Deploy Outlook Add-In on End-User's Computers
Configure the Outlook Add-In in the File   Send dialog box on the Web tab in the EFT 
administration interface   before deploying the EFT Outlook add-in on end-users' 
computers.

To   deploy the EFT Outlook add-in on end-users' computers
 1. In the administration interface, connect    to EFT and click the Server tab.
 2. On the Server    tab, click the Site you want to configure.
 3. In the right pane, click the Web    tab.
 4. Next to Send Portal,    click Configure. The File send dialog box appears.
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Do one of the following:

 l Use     the EFT Outlook add-in installer.     Click Browse to open C:\Program 
Files\Globalscape\EFT Server\OAI Installers, get the EFT Outlook add-in     
installer, and install the EFT Outlook Add-In as described in     Installing     the 
EFT Outlook Add-In. Choose either the EXE or the MSI file.     (The EXE will 
launch the MSI.)

 l EFTOutlookAddinSetup.exe      will check if Microsoft Outlook is 
present, install any missing      pre-requisites, and then launch the .MSI to 
install the add-in.      When you run the "EXE" make sure the "MSI"      file is in 
the same directory, as the "EXE" launches      the "MSI" as part of the 
install process.

 l EFTOutlookAddinInstaller.msi      will check if Microsoft Outlook is 
present, check whether      .NET 4.6 is present, and then install the add-
in. The "MSI"      will not check for or install any missing pre-requisites.      It 
only checks for the presence of Outlook and .NET.

-OR-

 l Use     the Outlook add-in deployment script.     Click View to open the     Outlook 
Add-in Deployment Script     box.

 a. Copy and paste the script into the tool you      are using to deploy the 
Outlook Add-In across your organization.

 b. Click OK      or press ENTER to close the Outlook      Add-in Deployment 
Script box.

 c. Edit the script to match your environment      (that is,  the EFTHOST IP 
address and port, username, password).

 d. EFT supports Manual authentication, which      is really Basic 
authentication, so you have to explicitly      provide the user's EFT 
username and password (that is, the      username and password that 
this Add-In user uses to log in      to EFT--not the administrator 
credentials). EFT also supports      Integrated Windows Authentication 
(IWA) where you don’t have      to explicitly provide a username and 
password if you are logged      into Windows with your domain account.

 e. Edit the Add-In installer command-line arguments      depending on the 
authentication type you want:

For manual authentication,      do the following (EFTUSERNAME and 
EFTPASSWORD values have      to be substituted with the actual Add-in 
user’s EFT username      and password):
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msiexec /lv installation.log      /qn /i 
EFTOutlookAddinInstaller.msi EFTHOST=https://WIN-
KST875BEBNP EFTPORT=443 
EFTAUTHTYPE=MANUAL EFTUSERNAME=username      
EFTPASSWORD=test123! 
INSTALLLOCATION="%userprofile%\AppData\Roaming\Glob
alSCAPE\EFT      Outlook Add-in" 
FILESTORELOCATION="%userprofile%\AppData\Local\Glob
alSCAPE\EFT      Outlook Add-in"

For Integrated      Windows authentication, do the following 
(EFTUSERNAME      and EFTPASSWORD don’t need to be supplied):

msiexec /lv installation.log      /qn /i 
EFTOutlookAddinInstaller.msi EFTHOST=https://WIN-
KST875BEBNP EFTPORT=443 EFTAUTHTYPE=IWA 
INSTALLLOCATION="%userprofile%\AppData\Roaming\Glob
alSCAPE\EFT      Outlook Add-in" 
FILESTORELOCATION="%userprofile%\AppData\Local\Glob
alSCAPE\EFT      Outlook Add-in"

Enabling Outlook's Language Detection
The EFT Outlook Add-In uses Outlook's proofing language detection to   determine in 
which language an email is written. If you want to enable   the Auto detect email 
language   setting, you must enable Outlook's Detect language automatically   proofing 
setting.

Before Outlook's Detect language automatically option   can detect the language that you 
are typing and enable the proofing tools   for that language, you must turn on the 
language-specific options you   want to use.

To turn on language specific options
 l For Microsoft Office 2007, refer to the Microsoft Office article    at 

http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-
languages-in-your-office-programs-HA010243503.aspx.

 l For Microsoft Office 2010 and later, refer to the Microsoft    Office article at 
http://office.microsoft.com/en-us/outlook-help/enable-the-use-of-other-
languages-in-your-office-programs-HA010354783.aspx.

To enable Outlook's Detect language automatically   proofing setting
 l For Outlook 2007, refer to the Microsoft Office article at 

http://office.microsoft.com/en-us/outlook-help/turn-on-automatic-language-
options-HA010244823.aspx.
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 l For Outlook 2010 and later, refer to the Microsoft Office article    at 
http://office.microsoft.com/en-us/outlook-help/turn-on-automatic-language-
options-HA010354274.aspx.

From the Microsoft Office links above: "Automatic     language detection does not work on 
a single-word basis, but on     a sentence basis. Depending on the length of your 
sentences, you     might need to type several sentences before Outlook has enough     
contextual information to automatically detect the language and     apply the correct 
dictionary."

Outlook must be restarted for the changes to take effect. After you   have turned on the 
language-specific options in Microsoft Office and enabled   Outlook's Detect language 
automatically proofing setting,   then the Add-In's automatic language detection feature 
will be enabled.

Mail Profiles with Multiple Accounts
Outlook 2010 and later support mail profiles with multiple mail accounts.   The Outlook 
Add-In seamlessly works with this new feature and (from a   user standpoint) there is no 
real difference in how the Add-In is used.   Emails with attachments can be sent from any 
of the mail accounts in the   profile and the Add-In will manage the emails that meet the 
policy criteria,   as usual. If an email is sent with the download notification feature turned   
on, the notifications will be sent to the account from which the email   was sent. The 
Status pane will   show an aggregated view of all packages that are being managed by 
the   Add-In for all accounts. If an account is disconnected from its mail server,   the Add-In 
will wait until connectivity is re-established for that account   before uploading 
commences.

The Outlook Add-In is supported with the following mailbox types:

 l Outlook 2010 and later support MAPI and POP

Recovering an Email from "Unrecoverable Error"
The Add-In will try to automatically recover from problems such as loss of connectivity 
with EFT during a transfer. If the Add-In experiences an “Unrecoverable Error” while 
managing a package, the Recover Email button appears. An unrecoverable error is a 
more serious error that the Add-In cannot resolve on its own, such as a file system error 
caused by EFT running out of disk space. These types of errors will usually require an 
administrator to resolve.
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If you click Recover Email, the Add-In will move the email corresponding to the package 
from Outlook’s Outbox to the Drafts folder. You can then try resending the email, perhaps 
after the administrator has had a chance to resolve the issue. If the problem cannot be 
resolved in a timely fashion, but you need to send the email promptly, you can stop the 
Add-In from managing emails by turning it off via the Outlook Trust Center.

 l To turn off the Outlook Add-In, refer to Enabling or Disabling the Outlook Add-In.
 l To edit message options, refer to Configuring Message Options.

Sending Files with the Outlook Add-In
If you have ever sent an email with attachments, you already know how   to use the 
Outlook Add-in. Create the email, attach one or more files   to the email, then click Send.   
You will continue to send and receive emails as always; the only difference   is that the 
Outlook Add-in works transparently in the background to transfer   the emails that have 
attachments.

 l The sent email is still saved to your Sent    Items folder, but the attachments, if 
managed by the Outlook    Add-in, are not saved in the Sent    Items folder. Instead, a 
link to the attachments is added to    the body of the email. The email saved to your 
Sent    Items folder looks the same as the recipient's received email,    minus the 
attachments. (Outlook's "Save Sent item to" option    is not supported in the EFT 
Outlook Add-In.)
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 l The attachment and message, if managed by the Outlook    Add-in, is saved on EFT 
in the location specified during installation,    in a unique folder for each email, not 
on your SMTP server (such as    Microsoft Exchange).

 l The Outlook Add-in stores information about emails    that it is processing in an 
individual workspace.

 l The administrator configures message-sending options    on EFT. You can 
configure more strict options in Outlook for all messages    or for specific 
messages. Refer to Configuring    Message Options for details.

 l You can send a secure message in Outlook without an    attachment, however, you 
cannot expire the message    immediately without an attachment.

Sending the email can fail   in the following situations:

 l Offline mode—Messages    are stored in the outbox until Outlook is online and the 
Add-In connects    to the server.

 l Loss of connectivity    to the server—Interrupted uploads due to loss of 
connectivity    to the server are continued from the point at which they were 
stopped    when connection to the server is re-established.

 l Insufficient disk    space—The Add-In will receive a FileSystemError response 
from    the server and the Add-In will treat this as an unrecoverable    error.

 l RTF-formatted emails—RTF-formatted    messages are not supported. To change 
the format for all messages    sent in Outlook, refer to Changing    the Message 
Format.

To send a file
 1. Create an email in Outlook as you normally do.
 2. Attach the file to the email using the EFT Outlook    Add-in Offload Attachments    

button.
 3. (Optional)    Click one or more of the following options:

 l Secure Message—To     send the email and its attachments as a secure 
message, click     Secure Message.     The attachment(s) and message body 
will be available to the recipient(s),     through a secure Pick-Up portal. A 
unique message containing a     unique link is created for each recipient. 
When processing a message in Outlook, if Secure Message is set (by user 
or mandatory), then that message will be processed by EFT, including any 
files (if any) that are attached. 

 l Expire File Links—When     selected, the ability to download the attachments 
will expire     in the time that you specify. If the recipient attempts to 
download     a file that is past its expiration date, the following message     
appears: “The file you are attempting to download has expired.     Please 
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contact the sender if this file needs to be resent.”
 o If you set the message to expire immediately      without attaching a file, 

you will receive an error message.
 o If the administrator has selected the Retain      files after link expiration 

check box, the temporary Workspace      is removed from the virtual file 
system in EFT, but the files      are still available on disk until the "retain 
files"      expiration date. 

 l Authentications—Require     the user to log in to download an attachment 
from the     Pick-up portal. Selecting this check box helps prevent unwanted     
downloads from email forwarding and such, and also helps guarantee     that 
the person downloading the file is the intended recipient.

 o If the user clicks on an individual file link,      the login or account creation 
page will be displayed in their      default browser. After authentication is 
successful,      the "open/save" dialog appears.

 o If the user clicks on the Pick-up portal link,      the login or account 
creation page will be displayed in their      default browser. After 
authentication is successful,      they will be taken to the Pick-up page for 
that specific package.

 o When the check box is selected, only the Pick-Up      page link is sent. If 
the check box is not selected, individual      links for each file are included 
in the email.

The authentication will be saved in their session, so clicking     multiple 
individual file links will not require multiple log-ins. (The     session length is 10 
minutes.)

 l Notifications—When     selected, download notification is sent to you when 
the recipient     clicks the download link in the email or "Download Files"     in the 
Pick-Up portal.

 4. Click Send.    The email the recipient will receive a delivery notification.
 5. The recipient can download the attachment from the    Web Transfer Client.
 6. If the attachment does not appear, the recipient might    need to click the refresh 

icon. Select the check box next to the file,    then click the Download icon.    The file is 
saved to the downloads folder in the recipient's browser.

Outlook Add-In User Guide globalscape.com page: 22

SendAndReplyPortals.htm
Pick_up_Files.htm


/ Viewing Add-In Status

Viewing Add-In Status
The EFT Outlook Add-In includes a Status   pane through which you can view whether 
you are connected to EFT and the   status of email attachments being sent. By default, 
the Status   pane is hidden. The pane appears on the right side of the main Outlook   
window.

To view EFT Outlook Add-in status
 l On the EFT Outlook    Add-In toolbar/ribbon, click Display    Status. The EFT 

Outlook Add-in    Status pane appears.

 o The General Status     area displays the status of your server connection. If 
the Outlook     Add-In is not connected to the server, it will not try to upload     
packages.

 o The Transfer     Status area displays the status of attachments being sent,     
including recipient, subject line, size of the file, status (Pending,     
Transferring, Verifying File Digest, etc.), and the number of     upload 
attempts.
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 o To dock or undock the Status     pane
 n Click and hold the title bar of the Status pane until the Move cursor       

appears (or click the down arrow on the title bar of the pane,      then click 
Move) then      drag the pane to undock it and move it where you want.

 n To dock the pane, click in the title bar,      and drag the pane back to the 
right or left side of the primary      Outlook window.

 n To resize the pane (when undocked) click and      hold a corner of the 
pane (or click the down arrow on the      title bar of the pane, then click 
Size),      then drag the pane to the size you want.

 o If the upload failed, the Transfer     Status area displays the following 
information:

 n Text-based description of current status,      including information on 
what prevented package from being      uploaded in error cases

 n Subject of the package
 n Recipients of the package
 n Total size of package
 n Number of upload retry attempts for package
 n Recover      Email button for failures that were the result of an 

unrecoverable      error. Clicking Recover Email      moves the email to the 
Outlook Drafts      folder.
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